School of Arts
Department of English & Humanities

MA CREATIVE WRITING
Academic Year 2016-2017

Contents

Welcome ......................................................... 1
Starting Your Course ................................. 3
Programme Structure .................................. 5
Aims & Outcomes of the Programme ............. 6
Module Information ........................................ 7
Coursework Presentation & Plagiarism ............ 26
Assessment Requirements ............................. 31
Disability & Dyslexia Service ......................... 35
Student Support & Available Resources ........... 37
Staff Profiles & Contact Details ....................... 38

Appendix A: Term Dates and Deadlines ........... 42
Appendix B: How to Format your Fiction ........... 43
Appendix C: Extracurricular Opportunities ......... 45
Appendix D: Getting Started with Moodle .......... 46
Appendix E: Campus Map ................................. 47

Published September 2016
This document is for reference only. Every effort was made to ensure that information was correct at time of print, but discrepancies may still occur due to the nature of this document. Any changes will be communicated to you via email or Moodle.
Welcome

When Birkbeck College was established in 1823, its principal mission was to provide education and training to working adults who earlier in life had lacked educational opportunity. A College of the University of London since 1920, Birkbeck is committed to the concept of lifelong education, and especially within the world of work. Birkbeck and the other member colleges of the University of London have many research interests in common and share the same standards and degrees structures, but in one important respect Birkbeck is unique. Our mission is ‘to provide courses of study to meet the changing educational, cultural and training needs of adults who are engaged in earning their livelihood, and others who are able to benefit’ (Birkbeck College Charter).

Birkbeck College has built up special expertise in providing a stimulating, positive learning environment for adult, mature students. Recently we have also expanded our provision for full-time postgraduate students. We award undergraduate degrees in a full range of disciplines and have an unusually high proportion of students following taught Masters and MPhil/PhD courses.

The MA in Creative Writing is a venture of the Department of English and Humanities in the School of Arts and can be taken full-time for one year or part-time over two-years. All classes are taught in the evenings. Supporting writers of fiction (with some provision for poetry, creative non-fiction, playwriting, screenwriting, and writing for young adults), our aim is to help you develop skills to a professional level in your chosen genre through workshops, regular tutorials and dissertation supervision, and to develop your critical understanding of contemporary literature. Students will benefit from the expertise of writers with international standing, as well as visiting publishers, editors and literary agents. Students can also volunteer as editors for the annual literary magazine, The Mechanics’ Institute Review that showcases student writing and facilitates contact between students and the creative industries and as interns on the Writers Hub website.

Students begin the programme in the autumn term with the Writing and Reading Seminar that concentrates upon the short story. Each weekly class is divided into a writing segment where students present and discuss their writing, and a critical segment in which essential works of short fiction are given close textual readings. In this way students engage in the art of reading as well as writing.

Also in the autumn term, full-time students will take one of the two Contemporary Literature Core Modules (part time students in their second year) that focuses on either genre (the structures of storytelling), or poetry and the critical theory propelling such work.

In the spring term the Writing Workshop will follow on from the Writing and Reading Seminar and concentrate solely on students’ own writing (part-time students take this in their second year). You will critique the work of your peers either whole short stories or sections of novels in progress.

The Option modules also run in the spring term (part-time students take an option in their first year). You will elect to study one module from a range offered by the department, but will need to nominate a second and third choice in the event your first choice option is full.
In the summer term there will be a series of lectures and **craft seminars** focusing on aspects of narrative art, and **visiting speakers** (such as a literary agent and an editor from a publishing house). These seminars and talks give crucial insights into the mechanisms of the novel and the cultural industries respectively and are not to be missed. The summer term is a non-assessed term.

Your **Dissertation Supervisions** will occur in the Summer Term by appointment with your tutor. Full time students will get two, one-hour supervisions. Part time students will have two half an hour supervisions in the first year and one, one hour supervision in the Second Year. All students will have to provide a short – one paragraph – synopsis of their Dissertation in the second half of the final Spring Term. This is to alert tutors to the subject and genre of their proposed Dissertation so staff can appoint appropriate supervisors.

At the end of the Summer term students will also be invited to show samples of work to agents in small group tutorials – 5,000 words and a short synopsis.

You will be assigned a Personal Tutor who is your first contact for any queries you may have about academic or pastoral issues.

Birkbeck is now a corporate member of the **Royal Society of Literature**. More information can be found on their website at [www.rslit.org](http://www.rslit.org).
Starting your Course

Enrolment: Important Information
After receiving an offer of a place on the MA, you need to enrol as soon as possible (see administrative information, below). For early applicants this option is usually available from July onwards. Late applicants (those interviewed in August/September) may experience some delay in receiving their enrolment details at what is the busiest time of the year for Registry.

The College will expect you to have formally enrolled and to have begun paying your fees by mid-October. You must enrol by the end of October or you may not be eligible to continue your degree.

A student who withdraws after enrolling is liable for payment of fees for the first term of their intended study, and all subsequent terms up to and including the term in which they withdraw or for the full fees due for all modular enrolments (whichever is greater). Fees are not returnable, but requests for ex-gratia refunds of part of the fees paid in cases where a student is obliged to withdraw because of circumstances beyond the student's own control (but normally excluding changes in employment) may be made.

Fees/ Finance
College fees may be paid by many methods. Additional expenses will be incurred and it is important to budget for the purchase of books. Whilst we have great sympathy with students who find difficulties in paying their fees, neither the Course Director nor any of your supervisors have the power to waive fees or sanction delays in payment. The College Finance Office deals with fees and you should communicate and negotiate with them directly on 020 7631 6295. Students who fail to pay their fees may become ineligible to continue the course or unable to submit assessments. Any student who has a debt to the College at the end of the year will not have their marks relayed to them. The College fees policy can be found here www.bbk.ac.uk/mybirkbeck/services/rules/College-Fees-Policy.pdf

Contact Details/Email
Birkbeck students are required to maintain their personal details via the “My Studies” Portal (student intranet) throughout their period of study. Failure to maintain this information via your student portal will mean that you may miss important information concerning the course. You may nominate an email via your “My Studies” Student Portal. If you encounter any difficulty with this process please visit the MyBirkbeck Helpdesk in the main Malet Street building. Email is the normal means of communication in the School of Arts.

Location
The School of Arts is housed at 43 Gordon Square, where you will find the administrative office and individual staff offices. Teaching often takes place in our building, but your lectures may be held in any of the University of London or University College London buildings in the Bloomsbury area. Pigeonholes for communications with students are located at 43 Gordon Square. During term time the Gordon Square entrance is staffed from 8.00am to 9.00pm, Monday to Friday. Urgent messages outside these times can be left at the Malet Street reception desk, which is open until 10.00pm.

The Administrative Office
The School of Arts student advice desk is located in the foyer of 43 Gordon Square, and is open during term time from 5.00pm to 6.00pm Monday to Thursday. Outside office hours,
please contact your administrator by phone or e-mail to discuss your query or to book an appointment. 43 Gordon Square is open between 9.00am-6.00pm on Saturdays during term time for access to student pigeonholes and coursework delivery.

**Moodle (Birkbeck's Virtual Learning Environment Platform)**
You will be expected, throughout your studies, to submit relevant coursework via Moodle. You will need your Birkbeck College username and password in order to gain access to Moodle. Your username and password are created by ITS and all enrolled students will receive them. You cannot access this system if you are not enrolled. If you do not have your username and password, please contact ITS Reception in the main Malet Street building or by e-mail at its-helpdesk@bbk.ac.uk. If you have difficulty using Moodle, please contact/visit the ITS Help Desk where they can walk you through the process.

**Books: to buy or borrow?**
Throughout your degree you will be given reading lists, which will include both essential texts forming the basis of lectures and seminars, and suggestions for wider reading. The distinction between these two categories is clearly marked in this booklet. The first you will normally be expected to buy (particular versions or editions are specified in some cases) or photocopy from the short loan collection in Birkbeck Library. If you have trouble obtaining the recommended edition, or already own an alternative, a substitute will often be acceptable; consult the lecturer concerned if you are in any doubt. If you intend to rely on libraries, bear in mind that many other students will inevitably need the books at exactly the same time as you do. It is your responsibility to obtain these books in time for the classes. If you do find that a book has become unobtainable for any reason, please let the lecturer know as soon as possible.

**Attendance Requirements**
Taking a degree course at Birkbeck requires a high level of commitment, it is important that you attend lectures and classes consistently. **It is your responsibility to make sure your attendance is noted at every class you attend.** Please email both the module leader and administrator if you know that you will be absent from a class. It is accepted that through illness or exceptional pressure at home or at work you may have to miss occasional classes, but if you have to be absent from several classes, or you know that you are going to have difficulties in attending regularly, please inform your Programme Convenor. Birkbeck expects an attendance rate of at least 75%.
Programme Structure

Part-Time

<table>
<thead>
<tr>
<th>Part-time students</th>
<th>Term 1</th>
<th>Term 2</th>
<th>Term 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Year 1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Writing and Reading Seminar</td>
<td>Writing and Reading Seminar</td>
<td>Option Modules</td>
<td>Dissertation supervision</td>
</tr>
<tr>
<td>Wednesday</td>
<td>2 tutorials (up to 30 mins)</td>
<td>Various days</td>
<td>2 tutorials: up to 30 minutes</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Craft seminars and visiting professionals</td>
</tr>
<tr>
<td>Year 2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Contemporary Literature module</td>
<td>Contemporary Literature module</td>
<td>Writing Workshop</td>
<td>Dissertation supervision</td>
</tr>
<tr>
<td>Various Days</td>
<td></td>
<td>Wednesday</td>
<td>1 tutorial: up to 60 minutes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 tutorials (up to 30 mins)</td>
<td>Craft seminars and visiting professionals</td>
</tr>
</tbody>
</table>

Full-time

<table>
<thead>
<tr>
<th>Term 1</th>
<th>Term 2</th>
<th>Term 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Writing and Reading Seminar</td>
<td>Writing Workshop</td>
<td>Dissertation supervision</td>
</tr>
<tr>
<td>Wednesday</td>
<td>Wednesday</td>
<td>Two tutorials up to 60 minutes each</td>
</tr>
<tr>
<td>2 tutorials (up to 30 mins)</td>
<td>2 tutorials (up to 30 mins)</td>
<td></td>
</tr>
<tr>
<td>Contemporary Literature module</td>
<td>Option Modules</td>
<td>Craft seminars and visiting professionals</td>
</tr>
<tr>
<td>Various Days</td>
<td>Various Days</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Aims and Outcomes of the Programme

The aims of the programme are to enable students to:

- Develop to a professional level the craft of writing in a particular genre
- Develop confidence, sensitivity and discernment in their analysis of their own and their fellow students’ work
- Develop a greater critical understanding of contemporary literary developments
- Place their own writing in the context of developments in contemporary fiction
- Develop to professional level skill in editing of both their own and fellow students’ creative work
- Gain a greater practical knowledge and understanding of the markets for fiction
- Complete under supervision a creative dissertation of high literary quality

By the end of the programme students will have:

- Developed the skills and techniques involved in writing in a particular genre and in completing a substantial creative dissertation
- Developed a critical understanding of literary writing through study of contemporary movements and theory, close readings of individual texts and by placing your own work in relation to contemporary writers
- Gained practical knowledge of the publishing industry by learning how to present and market your creative work
- Completed and submitted for assessment a creative writing portfolio

Module Availability

We reserve the right to cancel modules that do not recruit the minimum student numbers as required by Birkbeck College. In addition, please remember that both the requirements of the Department and the personal circumstances of tutors may change over the course of the year. This booklet is for reference only.
Module Information

Autumn Term

The autumn term starts on Monday 26 September with an induction for all new students. This is an opportunity for you to meet tutors and fellow students and to learn more about the programme. It is important that you attend as the course pack for the Writing and Reading Seminar will be distributed, and class groups will be drawn up. Details of the induction will be sent to students via email closer to the date. The first class will run on Wednesday 5 October.

Writing and Reading Seminar

ENHU036S7
Wednesday
6:00pm-8.00pm
Tutors: Russell Celyn Jones, Julia Bell, Toby Litt

Module Aims and Outcomes
- Develop to a professional level the craft of writing in the short story genre
- Develop confidence, sensitivity and discernment in their analysis of their own and their fellow students’ work
- Develop a greater critical understanding of contemporary literary developments
- Place their own writing in the context of developments in contemporary fiction
- Develop to professional level skill in editing of both their own and fellow students’ creative work
- Gain a greater practical knowledge and understanding of the markets for fiction

Module Description
This module focuses on the student’s emerging creative writing and the significance of reading texts for the writer. Each of the ten sessions is divided into writing segments where students present a short story for the class to critique (These stories should be no longer than 4000 words in length but can be shorter). This is followed by a related critical segment where essential works of short fiction are given close textual readings from the point of view of style and construction.

<table>
<thead>
<tr>
<th>Assignment</th>
<th>Description</th>
<th>Weighting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coursework</td>
<td>4000 words</td>
<td></td>
</tr>
<tr>
<td>Assessed Essay</td>
<td>1000 words</td>
<td>100%</td>
</tr>
</tbody>
</table>

Required Texts
Required reading will be made available at the start of term (via the course reader or Moodle). It is your responsibility to read set texts in advance of class each week.

Optional Reading
Barry, Kevin, Dark Lies the Island (Vintage, 2013)
Barrett, Colin, *Young Skins* (Cape, 2014)
Bennett, Claire-Louise, *Pond* (Fitzcarraldo Editions, 2015)
Carter, Angela, *The Bloody Chamber and Other Stories* (Gollanz, 1979)
Carver, Raymond, *Where I'm Calling From* (Harvill, 1993)
Chekhov, Anton, *The Kiss and other Stories* (Penguin, 1982)
Davis, Lydia, *Almost No Memory* (Picador USA, 2001)
Joyce, James, *Dubliners* (Penguin, 2007)
July, Miranda, *No One Belongs Here More Than You* (Canongate 2007)
Keegan, Claire, *Antarctica* (Faber, 1999)
Lawrence, D.H., *Collected Short Stories* (Everyman’s Library, 1994)
McGregor, Jon, *This isn't the sort of thing that happens to someone like you* (Bloomsbury, 2013)
Munro, Alice, *Too Much Happiness* (Vintage, 2010)
Saunders, George, *Tenth of December* (Bloomsbury, 2013)

**Further Reading**
O’Connor, Flannery, *Mystery and Manners* (Faber, 1984)

**Websites**
Thresholds Short Story Forum: [http://blogs.chi.ac.uk/shortstoryforum/](http://blogs.chi.ac.uk/shortstoryforum/)
New Yorker Fiction Podcasts: [http://www.newyorker.com/online/blogs/books/podcast/](http://www.newyorker.com/online/blogs/books/podcast/)
Contemporary Literature Modules

Please note that options will only run if student numbers meet the School of Arts minimum requirement, and therefore undersubscribed options may be cancelled.

Contemporary Literature: Poetry Workshop
AREN120S7
Thursday
6:00-8:00pm
Tutor: Martina Evans

Fiction is a language art and a narrative form. Everything however, is built out of the sentence. Not just a carrier of narrative, a sentence has to be its own story. It needs to be declarative and arresting. In other words, the sentence has to do everything.

One of the best training grounds for the novelist on the level of the sentence is a poetry workshop. Poetry is a concentration of language, where not a single word can be wasted. Poetry also has rhythm and musicality.

This poetry workshop will be useful to all students of fiction who want to improve their literary language skills and push the sentence to another level of expertise.

Learning Objectives and Aims
On successful completion of this module, students will be expected:
• To be able to compose poetry at a formal and experimental level.
• To demonstrate knowledge of various set forms
• To evaluate their own work in a critical fashion.
• To apply their new skills to other modes of writing.
• The module will further provide students with a broad knowledge of published poetry

Communication skills learned in the workshop will aid them both socially and professionally.

Module Description
The requirements of poetry, whether we are writing in a strict form or not, often force — and free us to surprise ourselves, and to make discoveries in and with our writing, as we’re writing. At the same time, poetry’s emphasis on the texture of writing along with its relative compactness make it a very efficient means of homing in on and developing certain aspects of craft.

This module is designed to give fiction writers the opportunity to enhance their skills through the study and practice of the techniques of the poet. We will combine close readings of canonical and contemporary poems with writing exercises and the process of the workshop to explore such weekly themes as: the power of the image, the sounds of sense, the devil in the detail, objective correlative, character in action, the reach of connotation, the riches of understatement, the endless possibilities of lyrical time, the sympathetic contract, masks, voices and catching and shifting the tone, duende and negative capability.
Through these themed topics, students will extend their understanding of how form and structure (including sound and rhythm) contribute to meaning; how metaphors and symbols grow out of images (and how to harness the power of figurative language); how “writing off the subject” is often the best way in; how inference and innuendo can draw the reader on and how writing that addresses the senses invites the reader to make the experience his or her own.

Coursework and Assessment

<table>
<thead>
<tr>
<th>Assignment</th>
<th>Description</th>
<th>Weighting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assessed Essay</td>
<td>1500 word essay on one aspect of the craft of poetry</td>
<td>100%</td>
</tr>
<tr>
<td>Portfolio of Poems</td>
<td>Up to 12 poems (approximately 100-150 lines), some of which have been previously submitted to the workshop</td>
<td>100%</td>
</tr>
</tbody>
</table>

Coursework Deadline
Monday 9 January 2017

Required Reading
Seamus Heaney, The Government of the Tongue (Faber 1979)
Al Alvarez, The Writer’s Voice (Bloomsbury, 2005)
The course-book anthology of poems
A selection of essays posted weekly on Moodle during the term.

Recommended Reading
Salzman, Eva and Wack, Amy Eds., Women’s Work, (Seren, 2008)
Williams, William Carlos, I Wanted to Write a Poem, Norton, 1982
Paterson, Don, Ed., 101 Sonnets (Faber, 1999)
Rilke, Rainier Maria, Letters to a Young Poet Penguin Books, 2011
Lowell, Robert, Life Studies (Faber, 1959)
Hugo, Richard, The Triggering Town, Norton, 1979
Komunyakaa, Yusef, Scandalize My Name: New and Selected Poems, Picador, 2002
Carson, Anne, Nox, New Directions, 2010
Howe, Marie, What the Living Do, Norton, 1999

Websites
The Poetry Library: http://www.poetrylibrary.org.uk/
The Poetry Society: http://www.poetrysociety.org.uk/
Poetry Foundation: http://www.poetryfoundation.org/
Academy of American Poets: http://www.poets.org/
Module Description
Whatever your voice or thematic preoccupation, it’s almost a certainty that you will have to place your characters within a compelling story if they are to engage the reader from the first page to the last. Easier said than done, perhaps. Conflict, passion, risk and uncertainty are the powerful forces at work in the world of your characters, but how can you channel these into an effective plot that provokes the reader into turning the pages?

There are few better ways of exploring these issues than looking at what is often labeled “genre fiction”. Dealing predominantly with matters of plot and narrative, this module will focus as much on the underlying and archetypal structures that genre stories seem to share as on the features that distinguish one genre from another.

We will read and dissect examples of historical fiction, crime fiction and Young Adult fiction.

Learning Aims and Objectives
This module will:
• Begin to develop your skill as a writer of genre.
• Give you a broad understanding of the textual strategies underlying a range of genres that dominate contemporary story-telling.
• Develop your skills of self-evaluation and constructive analysis of your own work and the work of others.
• Provide you with a strong sense of the principles of narrative and plot structure.
• Enable you to understand how generic expectation within the reader is an important tool to be exploited.
• Enable you to engage imaginatively in the analysis and interpretation of published novels and develop your own practice as a writer.
• Respond more effectively to the work of others; to participate in workshop or small group discussion by listening and contributing ideas in a sensitive and informed manner.
• Demonstrate an awareness of the industry-standard expectations for the presentation of your creative work.

Coursework and Assessment
You will be expected to write 1000 words in each genre for homework, and choose one genre in which to write your final submission coursework.

<table>
<thead>
<tr>
<th>Assignment</th>
<th>Description</th>
<th>Weighting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Genre fiction piece</td>
<td>3000 words in either of the three genres studied</td>
<td>100%</td>
</tr>
<tr>
<td>Critical/reflective essay</td>
<td>2000 words</td>
<td></td>
</tr>
</tbody>
</table>

Coursework Deadline
Monday 9 January 2017
Module Content

**Week 1**
Oct 6<sup>th</sup>  
**Introduction: Genre and Narrative in Storytelling**  
Module Introduction • The assignments •  
CLASS DISCUSSION: How do the elements of narrative work within genre?

**Week 2**
Oct 13<sup>th</sup>  
**Historical Fiction 1**  
The text studied will be David Mitchell, *Cloud Atlas* (2004). There will be a plenary lecture after which the students will be divided into two seminar groups.  
Reading for week 3: Roland Barthes, “Introduction to the Structural Analysis of Narratives”.

**Week 3**
Oct 20<sup>th</sup>  
**Historical Fiction 2**  
This week the students will work in their seminar groups for the entire session, discussing *Cloud Atlas* further, as well as the homework and reading from the previous week.

**Week 4**
Oct 27<sup>th</sup>  
**Crime Fiction 1**  
The text to be discussed will be Patricia Highsmith, *The Talented Mr. Ripley* (1955). There will be a plenary lecture after which the students will be divided into two seminar groups.  
Reading for week 5: Patricia Highsmith, extract from *Plotting and Writing Suspense Fiction*.

**Week 5**
Nov 3<sup>rd</sup>  
**Crime Fiction 2**  
This week the students will work in their seminar groups for the entire session, discussing *The Talented Mr. Ripley* further, as well as the homework and reading from the previous week.

**Week 6**
Nov 10<sup>th</sup>  
**Reading Week**

**Weeks 6 & 7**
Nov 10<sup>th</sup> & 17<sup>th</sup>  
**Workshops**  
We will begin to look at extracts from your fiction assignment. Students will work in their seminar groups.

**Week 8**
Nov 24<sup>th</sup>  
**Young Adult fiction 1**  
The texts to be discussed are Patrick Ness, *The Knife of Never Letting Go* (2008), and Joy Nicholson, *The Tribes of Palos Verdes* (1998). There will be a plenary lecture after which the students will be divided into two seminar groups.  
Reading for week 9: Freud, ‘The Uncanny’ (extract).
**Week 9**  
**Young Adult fiction 2**  
Dec 1st  
This week the students will work in their seminar groups for the entire session, discussing further the two YA texts, as well as the homework and reading from the previous week.

**Week 10**  
**Workshop**  
Dec 8th  
We will continue to look at extracts from your fiction assignment. Students will work in their seminar groups.

**Week 11**  
**Tutorials**  
Dec 15th

**Required Reading (Fiction)**  
Highsmith, Patricia, *The Talented Mr. Ripley* (1955)  

**Required Reading (Non-Fiction)**  
Freud, Sigmund, “The Uncanny” (1919) (photocopied extract to be supplied).  
Highsmith, Patricia, *Plotting and Writing Suspense Fiction* (1966) (photocopied extract to be supplied).  
Mabey, Edward *Dramatic Construction* (1972) (photocopied extract to be supplied).  

**Recommended Reading**  
Students are not required to buy these books but they are recommended as useful ancillary reading for the module:  
Sallinger, J. D., *The Catcher in the Rye* (1951)  

**Spring Term**  
The Spring term begins on Monday 9 January 2016. Full and part-time first year students take one option course (Creative Writing option details follow here and online). Full-time and second year part-time students also take the Writing Workshop.
The Writing Workshop
ENHU039S7
Wednesday
6:00-8:00pm
Tutors: Russell Celyn Jones, Julia Bell, Toby Litt

Module Outcomes and Aims
- Develop to a professional level the craft of writing in either the short story or novel genre
- Develop confidence, sensitivity and discernment in their analysis of their own and their fellow students’ work
- Develop a greater critical understanding of contemporary literary developments
- Place their own writing in the context of developments in contemporary fiction
- Develop to professional level skill in editing of both their own and fellow students’ creative work
- Gain a greater practical knowledge and understanding of the markets for fiction

Module Descriptions
This workshop follows on from the Writing and Reading Seminar and centres upon students’ own writing (5000 words maximum per submission). There will be no published texts used in the workshop. Instead ongoing reference will be made to specific examples of contemporary writing that relate in some way to each student’s work. You will have the opportunity to continue writing short stories or begin to develop a novel with the critical support of the class.

Coursework and Assessment

<table>
<thead>
<tr>
<th>Assignment</th>
<th>Description</th>
<th>Weighting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coursework</td>
<td>5000 words</td>
<td>100%</td>
</tr>
</tbody>
</table>

Coursework Deadline
Monday 24 April 2017

Required Texts Reading
Lodge, David, The Art of Fiction (Penguin, 1992)

Further Reading
Bennet, Alan, Writing Home (Faber, 1998)
Berger, John, Ways of Seeing, (Penguin, 1972)
Cixous, Hélène, Three Steps on the Ladder of Writing (Columbia University Press, 1993)
Cuddon, J. A., Book of Literary Terms and Literary Theory (Penguin, 1992)
Eagleton, Terry, Literary Theory (Blackwells, 1996)
O’Connor, Flannery, Mystery & Manners: Occasional Prose (Farrar Straus Giroux, 1969)
Sellers, Susan, ed., Taking Reality By Surprise (Women’s Press, 1991)
Option Modules

Options are allocated on a first come, first served basis. Students select ONE of the following modules, nominating a SECOND & THIRD choice in the event your first choice module is oversubscribed. You will be asked to record your choices via an Online Bristol Survey (deadline is Monday 31 October).

*Please note that options will only run if there are enough students and therefore undersubscribed options may be cancelled.*

You are strongly advised to give careful consideration to options offered by the Department of English and Humanities and not just those options taught by members of the creative writing team. The opportunity to study under world-class academics is a chance not to be missed that will extend your range of literary reference and help contextualise your own writing.

Full details of all the options offered by the Department are available online, you will be sent the relevant link in due course.
Creative Non-Fiction
ENHU002S7
Thursday
6:00-8:00pm
Tutor: Julia Bell

Module Outcomes and Objectives
By the end of this module students will have gained:

- An awareness of the styles, forms and elements of the non-fiction writer’s craft, including the processes of research and exposition.
- An understanding of recent and contemporary creative non-fiction across a range of forms and genres (travel, nature, life writing, reportage, creative documentary, verbatim theatre), and an understanding of its place within literary canons.
- The confidence to tackle craft-related problems in areas such as structure, setting, atmosphere, and the use of dialogue and telling detail.
- The confidence to recognise and understand sources of inspiration and creativity.
- The ability to use research-generated ideas more confidently, precisely, and imaginatively.
- Confidence in handling a variety of research methodologies (whether electronic, archival, interview-based or investigative), with insight and creativity.
- An awareness of the industry-standard expectations for the presentation of non-fiction writing, including its bibliographic and citation conventions.
- Enhanced skills of self-evaluation as well as constructive analysis of the work of others.
- The critical and creative skills needed to realise a personal writing project, taking it from initial idea, through research to writing and editing.

Module Description
“*We like non-fiction because we live in fictitious times*” – Michael Moore

This ten-week module aims to develop the understanding and practice of non-fiction writing in all its forms, covering all aspects of the craft from ideas to research and writing. It will be taught through an interactive mix of reading, writing, discussion and peer appraisal.

The course will be split into two five week periods. The first five weeks focused on reading, discussion, and exercises. The second five weeks will give every student an opportunity to workshop ONE piece of work of up to 5,000 words.

During the first 5 weeks each student will be expected to deliver a short (8 minute) presentation on that week’s set text. The presentation can be about any aspect of the book that interests them, but as well as subject, we will be looking at structure, delivery, style and technique.

**EVERYONE** is expected to read the five set texts – even if they are not presenting - the secondary reading would be helpful but is not essential.
The assessment for the course will comprise a piece of original Creative Non-Fiction of up to 5,000 words and a short 1,000 essay on one of the set texts. Each student will have ONE 30 min tutorial will the tutor in the second half of term.

**Module Content**

<table>
<thead>
<tr>
<th>Week 1</th>
<th>Oct 6th</th>
<th>Introduction: the ‘truth’ vs the Truth</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>What The Garbageman Knows – Peter Hessler (New Yorker)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Week 2</th>
<th>Oct 13th</th>
<th>Politics: SET TEXT: Funder, Anna – Stasiland (Granta, 2011)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Secondary Reading: Orwell, George - Down and Out in Paris and London (Penguin Classics, 2001)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Week 3</th>
<th>Oct 20th</th>
<th>Place: SET TEXT MacFarlane, Robert - The Wild Places (Granta, 2008)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Secondary Reading: Jaime, Kathleen - Findings (Sort of Books, 2005); Solnit, Rebecca, A Field Guide to Getting Lost (Canongate, 2008)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Week 4</th>
<th>Oct 27th</th>
<th>Personal: SET TEXTS: Winterson, Jeanette, Why Be Happy When You Could Be Normal (Vintage, 2012); vs Oranges Are Not The Only Fruit (Vintage, 1991)</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Week 5</th>
<th>Nov 3rd</th>
<th>Society: Capote, Truman – In Cold Blood (Penguin, 2001)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Secondary Reading: Burn, Gordon - Somebody’s Husband, Somebody’s Son (Faber, 2004)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Week 6</th>
<th>Nov 10th</th>
<th>READING WEEK Workshop 1</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Set essay (will be provided on Moodle): Consider the Lobster – David Foster Wallace</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Week 7</th>
<th>Nov 17th</th>
<th>Workshop 2</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Set essay: Psychogeography – Merlin Coverly</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Week 8</th>
<th>Nov 24th</th>
<th>Workshop 3</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Set Essay: The Empathy Exams – Leslie Jamison</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Week 9</th>
<th>Dec 1st</th>
<th>Workshop 4</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Set Essay: John Jeremiah Sullivan – Upon This Rock</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Week 10</th>
<th>Dec 8th</th>
<th>Workshop 5</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Assignment</th>
<th>Description</th>
<th>Weighting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coursework</td>
<td>5000 words, the assessment is via a 5,000-word piece of original creative non-fiction.</td>
<td>100%</td>
</tr>
</tbody>
</table>
Further Reading

Essential

Cline, Sally and Midge Gillies, *The Arvon Book of Literary Non-Fiction* (Bloomsbury, 2012)

Recommended

Bechdel, Alison, *Fun Home A Family Tragicomic* (Jonathan Cape, 2006)
Bourdain, Anthony, *Kitchen Confidential* (Bloomsbury, 2000)
Carey, John (ed.), *The Faber Book of Reportage* (Faber, 1996)
Clanchy, Kate, *Antigone and Me* (Picador, 2010)
*Granta 66: Truth + Lies* (Granta, 1999)
*Granta 102: The New Nature Writing* (Granta, 2008)
Greenlaw, Lavinia, *The Importance of Music to Girls* (Faber, 2007)
Gutkind, Lee (ed.), *In Fact: The Best of Creative Nonfiction* (W. W. Norton, 2005)
Hammond, Will (ed.), *Verbatim Verbatim: Techniques in Contemporary Documentary Theatre* (Oberon, 2008)
Hersey, John, *Hiroshima* (1946; Penguin Modern Classics, 2002)
Jack, Ian (ed.), *The Granta Book of Reportage* (Granta, 2006)
Jamie, Kathleen, *Sightlines* (Sort Of Books, 2012)
Kingsolver, Barbara, *Small Wonder: Essays* (Faber & Faber, 2002)

Masters, Alexander, Stuart: *A Life Backwards* (Harper Perennial, 2007)


Oswald, Alice, *Dart* (Faber and Faber, 2002)


Schama, Simon, *Dead Certainties: Unwarranted Speculations* (Granta, 1991)


Wallace, David Foster, *Consider the Lobster, and Other Essays* (Abacus, 2007)

Introduction to Screenwriting
ENHU040S7
Tuesday
6.00-8.00pm
Tutor: David Stafford

Learning Objectives and Aims
- An advanced understanding of the craft of professional screenwriting as it’s currently practised in the industry.

Module Description
This module will give students as thorough a grounding in the art, craft and business of writing for the screen as possible in ten weeks. Through a mix of interactive seminar presentations, assignments, workshops and analyses of produced screenplays (both on screen and on the page), we will develop an appreciation and understanding of:

- the tools of screenwriting (plot structure, characterisation, theme, dialogue etc.)
- (ii) knowledge of that which distinguishes the process of writing for the screen from writing prose fiction or stage drama.

During the course of the module, we will look at screenwriting techniques relevant to a wide range of genres and screenwriting forms. By the end of the module students will have produced two drafts of an original script (15-30 correctly formatted pages), analyzed a feature-length screenplay and viewed an wide range of complementary material.

Note: the screenplay you are required to read will be made available to you at some point during the Autumn term before the module starts; more titles will be added to the “Film for analysis” list in due course.

<table>
<thead>
<tr>
<th>Assignment</th>
<th>Description</th>
<th>Weighting</th>
</tr>
</thead>
<tbody>
<tr>
<td>An original short script</td>
<td>15-30 correctly formatted pages</td>
<td>100%</td>
</tr>
</tbody>
</table>

Required reading
Snyder, Blake, *Save the Cat!* (Michael Wise Productions 2005)

Scripts for analysis
*In The Bedroom* by Rob Festinger and Todd Field

Films for analysis
*Notting Hill* (1999, dir: Roger Michell)

Suggested further viewing
*Top Gun* (1986, dir: Tony Scott)

Suggested further reading
McKee, Robert, *Story* (Methuen, 1999)
Introduction to Playwriting
ENHU124S7
Tuesdays
6.00-9.00pm
Tutor: Jonathan Kemp

Learning Outcomes and Objectives
This module will:
- Provide a coherent and gradated introduction to writing for the dramatic form and thereby enable students to broaden their skills’ base.
- Deepen students' awareness of the dramatic form and the playwright's craft.
- Develop students' skills of self-evaluation and constructive analysis of their own dramatic work, and that of others.
- Enable students to develop skills in editing and revising their own playwriting.

Having taken this module the successful student will be able to:
- Demonstrate awareness and control of the elements of dramatic writing.
- Discuss and evaluate the work of fellow students and established playwrights in relation to elements of craft.
- Experiment with style and form.
- Solve craft-related problems in their own dramatic work.
- Implement the practice of redrafting and editing.

Module Description
This module offers students the opportunity to develop both their understanding of and writing skills in playwriting from first principles to final draft. Through weekly workshops the student will also consider the various means of theatrical production and the nature of the business of writing for the stage. The weekly sessions combine presentations by both lecturer and student on aspects of craft, writing exercises and feedback, analyses of canonical and contemporary plays, and ongoing script development. The student will gain a thorough grounding in the fundamental elements of playwriting such as: dramatic structure, character, dialogue, subtext and the manipulation of theatrical space and time. By the end of the module students will have produced two a workshopped short original play script or an excerpt of a full length play (4500 words including stage directions), and a 1000 word reflection on the process of developing the piece and the dramaturgical challenges and choices involved.

NB In the event of this module being oversubscribed, the 15 available places will be offered to the first five students to apply from each of the MA Creative Writing and MFA Theatre Directing programmes.

<table>
<thead>
<tr>
<th>Assignment</th>
<th>Description</th>
<th>Weighting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original Playscript</td>
<td>Either a complete one act play or part of a full length script, (4500 words) (formatted to industry standard)</td>
<td>85%</td>
</tr>
<tr>
<td>Essay on craft</td>
<td>1,000 words</td>
<td>15%</td>
</tr>
</tbody>
</table>
Suggested further reading:
Aristotle, Poetics, (Dover Thrift, 1997 or any edition)
Barker, Howard, Arguments for a Theatre, (Manchester University Press, 1997)
Beckett, Samuel, The Complete Plays, (Faber)
Brook, Peter, The Empty Space, (Penguin, 1968, or any edition)
Churchill, Caryl, A Number, (Churchill Plays 4, Nick Hern Books, 2008)
Edgar, David (ed), State of Play: Playwrights on Playwriting, (Faber & Faber, 1999)
Kane, Sarah, Complete Plays, (Methuen, 2001)
Mamet, David, A Whore’s Profession, (Faber, 1994)
Pinter, Harold, The Caretaker, (Faber 1991, or any edition)
Sophocles, Oedipus the King, (Penguin, 1984 or any edition)
Teevan, Colin, How Many Miles to Basra?, (Oberon 2007)
Teevan, Colin, Missing Persons: Four Tragedies and Roy Keane, (Oberon, 2006)
Summer Term

The summer term is a non-assessed term, however attendance at the lectures and craft seminars is compulsory. You will receive dissertation supervision and there will be an eight-week series of lectures and craft seminars focusing on aspects of narrative design, together with talks from visiting speakers. Previous speakers have included prizewinning authors, literary agents, book publishers and specialists on e-publishing.

Dissertation
ENHU002D7
For full-time students in year 1; part-time students in year 1 and 2
By appointment

Module Aims and Outcomes
- Develop to a professional level the craft of writing in the short story or novel genre
- Develop a greater critical understanding of contemporary literary developments
- Place their own writing in the context of developments in contemporary fiction
- Develop to professional level skill in editing of their own creative work
- Gain a greater practical knowledge and understanding of the markets for fiction

Module Description
Students work with their supervisors on the dissertation in one-to-one tutorials. For practical and pedagogic reasons the structure of the supervisions is slightly different for part-time and full-time students. Supervision slots will be available from mid-May through to the beginning of July. Students are expected to make appointments with tutors through the online diary, Doodle.

ALL students are expected to submit a short synopsis of their proposed Dissertation in the Spring Term of their final year. The synopsis need only be 200 words long, giving a short sense of the form (short-story, novel, script) and territory of the work. This is to help us assign you an appropriate supervisor and to focus thinking about the Summer Term’s writing, which is expected to be more self-directed.

Part-time students have two half an hour supervisions in their first year followed by another one-hour tutorial in their second year. In the first year, you will be expected to produce two short extracts of up to 3,500 words for each tutorial. The focus of these tutorials will be developmental, with a close focus on your prose and ideas. In the second year you will have a one hour supervision for which you will need to produce 7,000 words and which will focus on your dissertation submission and your writing progress.

Full-time students have two one hour tutorials in their final term for which they will be expected to produce 7,000 words per supervision.

The work can be a section of a novel, or several short stories, a piece of creative non-fiction, or a screenplay, but must not be work that has already been marked as your assignments for modules. The supervisors need you to send this work to them by email attachment no later than ONE WEEK before the date of the supervision. Full-time students will have a second supervision with a different tutor than the first, but should NOT
resubmit an improved version of the writing for the second tutorial; rather they need to
produce new work. The aim of these tutorials is to help and guide you towards the writing
of the 15,000 word dissertation itself, due in September of your graduating year and also to
discuss your on-going writing projects. You will get oral feedback from tutors, with some
annotation on the scripts themselves.

The Dissertation is normally submitted by mid-September. The completed Dissertation
must include a 3,000 word **preface**. If submitting a novel extract you may include a brief
synopsis, if necessary, that does not have to be included in the word count.

**Note on preface**: this is a hybrid form of literary essay/critical self-assessment. Students
should discuss lucidly the development of their writing in terms of the literary influences
upon it, and describe the personal journey involved in making a work of fiction over the
course of the programme. You can discuss an aspect of your research, or the development
of your technique but it requires some sense of your journey as a reader too and requires a
bibliography of at least six influencing texts.

<table>
<thead>
<tr>
<th>Assignment</th>
<th>Description</th>
<th>Weighting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dissertation</td>
<td>15,000 words</td>
<td>100%</td>
</tr>
<tr>
<td>Preface</td>
<td>3,000 words</td>
<td></td>
</tr>
</tbody>
</table>

**Important Information**

Part-time students should normally complete the term one Writing and Reading module
before beginning Dissertation supervision.

Full-time students should normally have completed all the modules in the programme before
beginning dissertation supervision.

**Please note**: to remove the possibility of students duplicating work previously submitted
for assessment, all dissertation material must **not** have been previously assessed. New work
(stories or novel extracts) should be submitted for dissertation supervision in the summer
term and for eventual submission for final assessment in September.
The Mechanics’ Institute Review is an annual magazine of short fiction by Birkbeck Creative Writing students, and MACW Alumni. A call for submissions is sent out annually in December and students can volunteer to form an editorial team who will be responsible for selecting the material to be published. The aim of the magazine is to showcase the best new fiction by Birkbeck writers, with a distribution beyond the university to literary agents, publishers, etc. Students will be expected to make decisions on format, content, design, and production, as well as oversee the physical manufacture and launch of the magazine. Although students who volunteer will not be eligible to submit work to that year’s issue of MIR, they will be able to submit in subsequent years. Students are encouraged to visit London Bookfair in April (free to students). A call for volunteers will go out in November.

***

Visiting Agents
At the end of the Summer Term final year students will have the opportunity to show their work to a literary agent and have a meeting with them. This arrangement is discretionary and entirely dependent on availability of agents’ time, and in the first instance you will be expected to submit a short extract of your work with a synopsis.
Coursework Presentation and Plagiarism

Guidelines and Style sheet

References within your essay and the bibliography should be full, consistent and properly presented. You are expected to consult and follow the MHRA Style Book where a much fuller discussion of presentation is to be found. It can be downloaded from the Department of English and Humanities website: http://www.mhra.org.uk/Publications/Books/StyleGuide/download.shtml.

Essays for options run by departments other than English and Humanities should, however, follow their documentation guidelines.

While minor lapses (e.g. commas out of place, forgetting to mention the translator of a work in the bibliography) may be ignored if they are infrequent, you will be penalized for sloppy and inaccurate documentation. While doing your preparatory reading, it is important to take full and accurate references so as to avoid spending a great deal of time hunting back through works to find page numbers etc.

Often MA students underestimate the time it takes to prepare a successful essay. This is not only because of the extent of the reading required, but because constructing a carefully-documented piece, and dealing with a larger body of primary and secondary materials than you are likely to have experienced in writing undergraduate essays, is a time-consuming process. No matter how long you spend on doing the preparatory reading, leave yourself plenty of time to write your piece.

Presentation

Editions
Wherever possible, standard editions should be used, especially for passages essential to the argument of the essay. References to the same work should be to the same edition, unless differences between editions are relevant to the argument of the essay.

Quotations
Quotations must be accurate and should be checked carefully before the essay is submitted.

Prose quotations up to about three lines and verse quotations up to one full line should be incorporated into the body of the text. Longer quotations should be inset, in which case inverted commas are not needed.

Once the source of quotation has been clearly identified in a footnote, quotations from the same text and edition can be identified by page number (or line number, or act, scene and line number etc., as appropriate) in parentheses immediately after the quotations, thus avoiding unnecessary footnotes.

Footnotes
Footnotes should be succinct; they should not become miniature essays. There are good grounds for restricting footnotes to:

i) The identification of quotations and other essential documentation.

ii) Undeveloped references to other relevant material: ‘see also…’
Documenting footnotes should follow the sequences:

a) Printed books: author, title (underlined); editor’s name (if appropriate, preceded by ‘ed.’); place and date of publication (in parentheses); volume and/or page number(s).

b) Periodical articles: author, title of article (within single inverted commas); title of periodical (underlined); volume number; date of publication (in parentheses); page number(s).

**Sample footnotes:**

2. Hibbard, pp. 25-6 [a following reference to the same book]
4. Lois Whitney, ‘English primitavistic theories of epic origins’, *MP*, 21 (1924), 337 or *MP*, xxi (1924), 337

**List of Sources**

At the end of the essay should be listed all the works, including editions of the texts discussed, that have been consulted in its preparation. The list should be in alphabetical order of author. The conventional sequences are as follows:

**printed books**: author (surname first), title (underlined); editor (if appropriate); number of volumes (if more than one); place of publication [colon] publisher [comma] year of publication

**articles**: author (surname first); title in single inverted commas; title of periodical (underlined); volume number; date (in parentheses); numbers of first and last pages of article.

**Acknowledgements**

In footnotes and list of sources the student must make clear acknowledgement of ALL works, reports and sources from the internet used in writing the essay and should not descend to plagiarism or collusion. S/he should carefully note the University of London General Regulations for Internal Students, 9.5:

*Where the regulations for any qualification provide for part of an examination to consist of ‘take-away’ papers, essays or other work written in a candidate’s own time, course-work assessment or any similar form of text, the work submitted by the candidate must be his own, and any quotation from the published or unpublished works of other persons must be duly acknowledged.*

Plagiarism is the quotation, verbatim or virtually verbatim, of other people’s work, published or unpublished, without acknowledgement. Plagiarism carries severe penalties and may even warrant exclusion from the course. If in doubt about the protocols of acknowledgement, ask.

**Assessment**

All assessed essays are double-marked; a set of comments and a mark are returned to the student. These marks remain provisional until ratified by the external examiner at the Board of Examiners’ meeting in November of the following year.
Student Support
Any matters that students want to discuss that are directly related to the content of the MA should be discussed with the appropriate tutor. Staff telephone numbers and email addresses have been provided under contacts.

Plagiarism
Plagiarism, the act of taking somebody else's work and presenting it as your own, is an act of academic dishonesty, and Birkbeck takes it very seriously.

Examples of plagiarism include (but are not restricted to):
- copying the whole or substantial parts of a paper from a source text (e.g. a web site, journal article, book or encyclopaedia), without proper acknowledgement
- paraphrasing another's piece of work closely, with minor changes but with the essential meaning, form and/or progression of ideas maintained
- piecing together sections of the work of others into a new whole
- procuring a paper from a company or essay bank (including Internet sites)
- submitting another student's work, with or without that student's knowledge
- submitting a paper written by someone else (e.g. a peer or relative) and passing it off as one's own
- representing a piece of joint or group work as one's own.

If you knowingly assist another student to plagiarise (for example, by willingly giving them your own work to copy from), you are committing an examination offence.

What happens if plagiarism is suspected?
In October 2008, the College introduced a new three stage policy for dealing with assessment offences. The first stage allows for a very rapid and local determination for first or minor and uncontested offences. Stage two allows for a formal Department investigation, where a student wishes to contest the allegation or penalty, where there is an allegation of a repeat offence or for more serious cases. Stage three involves a centrally convened panel for third and serious offences, dealt with under the code of Student Discipline.

What if I am worried that I'm not referencing correctly?
Please see your module tutor or contact a member of the learning support team as soon as possible. Ignorance to Birkbeck’s commitment to student standards will not be accepted as an excuse in a plagiarism hearing. The following links from Birkbeck’s Registry provide some helpful information, but are not intended to replace any guidelines or tuition provided by the academic staff.

General Guidelines
http://www.bbk.ac.uk/mybirkbeck/services/facilities/support/plagiarism

Plagiarism
http://pps05.cryst.bbk.ac.uk/notice/bkplag.htm – Written for Birkbeck’s Registry.

Plagiarism FAQ
http://turnitin.com/research_site/e_faqs.html – Frequently Asked Questions from Turn It In.
Coursework Submission

All work should normally be computer-generated (using a format compatible with Microsoft Word, and not a PDF or similar). All work should be submitted double-spaced. Please note that the word count should include footnotes but excludes the bibliography.

Your work should normally be submitted electronically, via Turnitin (or, exceptionally, in case of difficulty with this system, by email to the administrator concerned). You may, exceptionally, also be asked to leave a paper copy in the coursework box in the entrance hall of 43 Gordon Square. You should also retain a copy yourself. **In no circumstances should essays be handed directly to the lecturer or seminar leader.**

Paper copies of coursework should be stapled in the top left-hand corner, with your completed coversheet forming the top page. It should be placed in an envelope which is clearly marked with the name of the lecturer and the module title. **Please do not put them in a folder or plastic sleeve: markers prefer to receive work simply stapled.**

For further information and instructions on how to submit coursework using Turnitin please see the appendices or visit the ITS Help Desk.

Return of Coursework

Coursework will *normally* be marked and returned electronically within 4-6 weeks from the stated submission date or the date of handing in, whichever is later. Larger modules and modules with numerous seminar groups, such as core modules, could take longer due to the number of students involved. There may also be a delay if the college is closed or if there are extended holidays during that 4-6 week period.

**Essays are never sent back to students by post. If online submission/return has not been used, your lecturer will advise the method by which your work will be returned – normally via the student pigeonholes in the entrance hall of 43 Gordon Square. Your administrator will email you to let you know when coursework has been marked. Please do not phone/e-mail to ask whether your essay has been marked unless the marking periods as above have elapsed.**

College Assessment Policy

It may also be useful to familiarise yourself with the official college assessment policy. Please see the following link:


Late Submission of work for assessment

College policy dictates how Schools will treat work that is due for assessment but is submitted after the published deadline. From 2008/9 any work that is submitted for formal assessment after the published deadline is given two marks: a penalty mark of 50% for postgraduate students, assuming it is of a pass standard, and the ‘real’ mark that would have been awarded if the work had not been late. Both marks are given to the student on a cover sheet. If the work is not of a pass standard a single mark is given.

If you submit late work that is to be considered for assessment then you should provide written documentation, medical or otherwise, to explain why the work was submitted late. You will need to complete a standard pro-forma (available here [http://www.bbk.ac.uk/mybirkbeck/services/administration/assessment/coursework/mitigating-circumstances](http://www.bbk.ac.uk/mybirkbeck/services/administration/assessment/coursework/mitigating-circumstances)) and submit it, with documentary evidence as appropriate, to your Tutor or
Programme Director. The case will then be considered by the appropriate sub-board or delegated panel.

If no case is made then the penalty mark will stand. If a case is made and accepted then the examination board may allow the ‘real’ mark to stand.

**Note:** If you are taking an option within another School please note that you will need to adhere to the deadline/extension policy of the School in which the option course is based.

**Dissertations**

It is particularly important to submit dissertations on the deadline date. This deadline is not negotiable. If missed, the candidate may not be examined in the same year and may have to wait another twelve months before being awarded the degree as MA examination boards meet only once a year, in November. Any difficulty in meeting the dissertation deadline should be brought to the attention of the Course Director at the earliest opportunity.
Assessment Requirements for the MA Creative Writing Programme

Assessment is based entirely on coursework. To pass the programme, students must complete all the coursework, which includes critical essays, creative pieces and the dissertation, and achieve an overall mark of 50 or above. Coursework should normally be submitted in the first week of the succeeding term. All manuscripts must be typed in Times New Roman and double-spaced.

Students who fail their dissertation are allowed to resubmit once.

Assessment Weighting

50% of the overall grade (average of the marks from four modules) includes:

- 12.5% Writing and Reading Seminar: creative piece and a short critical essay, 5,000 words in total.

- 12.5% Contemporary Literature Life Writing: piece of life writing, 4,000 words. Contemporary Literature Genre and Narrative: essay, or essay and short creative piece, 4,000 words in total.

- 12.5% The Writing Workshop: Creative piece (100%). 5,000 words.

- 12.5% Option Module: Assessment criteria varies with each option.

50% of the overall grade:
• Dissertation (18,000 words in total – not including bibliography)

Marking Scheme

Distinction
A 75% - 100%
A - 73% - 74%
A -- 70% - 72%

Merit
AB 69%
B++ 66% - 68%
B+ 63% - 65%
B(+) 60% - 62%

Pass
B 59%
B(-) 56% - 58%
B- 53% - 55%
B-- 50% - 52%
Assessment Criteria

Short Creative Pieces

A Pass should show:
- Engagement with the structure and conventions of a particular genre
- Understanding of the relationship between content and form
- Competent use of language
- Awareness of reader/audience

A Merit should also show:
- Confident handling of the structure of a particular genre
- Willingness to experiment
- Fresh (i.e. non-clichéd) use of language

A Distinction should also show:
- Ambitious and/or original choice of content
- Accomplished handling of chosen form
- Original use of language

Critical essays on contemporary writing

A Pass should show:
- Awareness of the variety and range of contemporary writing
- Ability to analyse the use of language in published writing
- Analysis of the relevant aspects of the 'craft' of writing
- Sustained critical thinking
- Competent use of language

A Merit should also show:
- A willingness to approach 'difficult' writing
- Ability to sustain a convincing critical analysis
- Fresh use of language

A Distinction should also show:
- Sharp critical insight into what makes a literary work successful against different criteria
- Awareness of critical methods and theories
- Fluent use of critical language

Dissertation

A Pass should show:
- Awareness of the strengths and limitations of the chosen genre and of its 'fitness for purpose'
- Ability to use structure and voice to develop elements of one or more of the following: narrative, theme, character, prosody
- Understanding of the relationship between content and form
- Competent use of fictional, dramatic or poetic techniques
• Awareness of reader/audience
• Commitment to editing
• Appropriate use of research (where relevant)

A Merit should also show:
• Ambition in both formal and thematic or narrative scope of the piece
• Development of distinctive writing 'voice'
• Ability to produce fresh (i.e. non-clichéd) passages of writing

A Distinction should also show:
• Ability to produce a fully realised, sustained piece of writing
• Originality of use of one or more of the following: language, form, content
Degree Regulations

Undergraduate and Postgraduate Study

The majority of Birkbeck’s programmes are offered as part of the College’s Common Award Scheme (CAS). Programmes will therefore have common regulations, and a common structure. This will help to ensure greater consistency of practice amongst programmes and will also make it possible for you to take modules from Departments across the College which are outside of your normal programme (subject to programme regulations and timetable constraints).

Some areas covered by CAS Regulations include:
  - Degree Structure
  - Degree Classification
  - Module Weighting
  - Marking Scheme
  - Failure and Re-Assessment
  - Plagiarism and Academic Offences
  - Mitigating Circumstances.

You are strongly encouraged to read the information provided here http://www.bbk.ac.uk/mybirkbeck/services/rules/CAS%20Regs%201516.pdf.

Research Ethics

All research involving human participants and confidential materials, carried out by students in the School of Arts is subject to an ethics approval process. This is to ensure that the rights of participants and researchers alike are protected at all times, and to underline our commitment to excellence in research across a wide range of subjects.

If you are undertaking any such research work for a dissertation, project, thesis etc. please complete the form ‘Proposal for Ethical Review template’ and pass this to your academic supervisor. The proposal will be reviewed and assessed as ‘routine’ or ‘non-routine’. In most cases it is envisaged that such work will be routine, and your supervisor will inform you of the outcome. In a small number of cases, the proposal may be referred to the School’s Ethics Committee for further consideration. Again, you will be informed of any outcome.

The proposal form is available through our departmental web pages (current students). If you have any queries, please speak to your supervisor in the first instance.

Further guidelines are available on the MyBirkbeck website at http://www.bbk.ac.uk/mybirkbeck/services/facilities/support/research-ethics.

Please Note

We do not undertake anonymous marking taking the view that it is unenforceable and unworkable as the small team of tutors develop a good knowledge of student work. This falls under the ‘practical work’ exception of Section 10 of the College assessment policy.
Support for students with Disabilities, Dyslexia and Mental Health Needs

At Birkbeck there are students with a wide range of disabilities, specific learning difficulties, medical conditions and mental health conditions (hereinafter referred to as disabled students). Many of them have benefited from the advice and support provided by the College's Wellbeing Centre. The Wellbeing Centre is located in G26 on the Ground floor of the Malet Street building.

All enquiries should come to the Wellbeing Centre (tel. 0207 631 6316), who will determine the appropriate referral to specialists in the Disability and Dyslexia Service and Mental Health Service. They can provide advice and support on travel and parking, physical access, the Disabled Students’ Allowance, specialist equipment, personal support, examination arrangements, etc.

On enrolment you need to complete a Study Support Plan (SSP), which will set out the reasonable adjustments that we will make with physical access, lectures, seminars, assessments and exams. After you complete this and provide disability evidence, we confirm the adjustments you require and then your department, examinations office, etc. will be informed that your SSP is available and adjustments can be made. You should contact the Wellbeing Service if any of your adjustments are not in place.

Access at Birkbeck

Birkbeck's main buildings have wheelchair access, accessible lifts and toilets, our reception desks and teaching venues have induction loops for people with hearing impairments, and we have large print and tactile signage. Accessible parking, lockers, specialist seating in lectures and seminars and portable induction loops can all be arranged by the Disability & Dyslexia Service.

The Disabled Students’ Allowance

UK and EU (with migrant worker status) disabled students on undergraduate and postgraduate courses are eligible to apply for the Disabled Students’ Allowance (DSA). The DSA provides specialist equipment including computers with assistive technology and training, personal help (e.g., study skills tutors, mentors and BSL interpreters) and additional travel costs for students who have to use taxis. It provides thousands of pounds worth of support and all the evidence shows that students who receive it are more likely to complete their courses successfully. The Wellbeing Centre can provide further information on the DSA and can assist you in applying to Student Finance England for this support. From September 2016, new students will receive their note-taking support from the University rather than the DSA.

Support in your Department

Your Department is responsible for making reasonable adjustments in learning and teaching and assessment, including permission to record lectures, specialist seating, extensions on coursework, etc. Whilst we anticipate that this support will be provided by the Programme Director, tutors and Programme Administrator in the Department, they will also have a Disability Lead. If you experience any difficulties or require additional support from the Department then they may also be able to assist you. They may be contacted through the Programme Administrator.

Support in IT Services and Library Services

There is a comprehensive range of specialist equipment for students with disabilities in IT Services. This includes an Assistive Technology Room, which may be booked by disabled students. We have software packages for dyslexic students (e.g. Claroread and Mind view), screen reading and character enhancing software for students with visual impairments available in our computer laboratories, specialist scanning software, large monitors, ergonomic mice and keyboards, specialist
orthopaedic chairs, etc. We have an Assistive Technology Officer, who can be contacted via IT Services.

The Library has an Assistive Technology Centre, where there is also a range of specialist equipment, including an electronic magnifier for visually impaired students, as well as specialist orthopaedic chairs and writing slopes. The Disability and Dyslexia Service Office refers all students with disabilities to the Library Access Support service, who provide a comprehensive range of services for students with disabilities and dyslexia.

**Examinations and Assessments**

Many disabled students can receive support in examinations, including additional time, use of a computer, etc. In exceptional circumstances, students may be offered an alternative form of assessment.

**Specific Learning Difficulties (e.g. dyslexia, dyspraxia)**

Mature students who experienced problems at school are often unaware that these problems may result from their being dyslexic. Whilst dyslexia cannot be cured, you can learn strategies to make studying significantly easier. If you think you may be dyslexic you can take an online screening test in the computer laboratories – the instructions for the screening test are available on the Disability Office website. If appropriate, you will be referred to an Educational Psychologist for a dyslexia assessment. Some students can receive assistance in meeting the cost of this assessment, either from their employer or from Birkbeck.

**Further information**

For further information, please call the Wellbeing Centre on 020 7631 6316 or email disability@bbk.ac.uk.
Student Support and Available Resources

The MyBirkbeck student portal [http://www.bbk.ac.uk/mybirkbeck/](http://www.bbk.ac.uk/mybirkbeck/) holds lots of information that you will find useful during your programme of study, as well as your own student profile (for your contact details, timetable and module results). Some important pages are listed here:

<table>
<thead>
<tr>
<th>Support Area</th>
<th>Link</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disability &amp; dyslexia support</td>
<td><a href="http://www.bbk.ac.uk/mybirkbeck/services/facilities/disability">http://www.bbk.ac.uk/mybirkbeck/services/facilities/disability</a></td>
</tr>
<tr>
<td>Computing &amp; IT support:</td>
<td><a href="http://www.bbk.ac.uk/mybirkbeck/services/facilities/computing">http://www.bbk.ac.uk/mybirkbeck/services/facilities/computing</a></td>
</tr>
<tr>
<td>Birkbeck Library</td>
<td><a href="http://www.bbk.ac.uk/lib/">http://www.bbk.ac.uk/lib/</a></td>
</tr>
<tr>
<td>Senate House Library</td>
<td><a href="http://www.bbk.ac.uk/lib/otherlibs/shl">http://www.bbk.ac.uk/lib/otherlibs/shl</a></td>
</tr>
<tr>
<td>Student support</td>
<td>(includes learning support, nursery, careers, accommodation and Students union info) <a href="http://www.bbk.ac.uk/mybirkbeck/services/facilities">http://www.bbk.ac.uk/mybirkbeck/services/facilities</a></td>
</tr>
<tr>
<td>Fees and financial support</td>
<td><a href="http://www.bbk.ac.uk/mybirkbeck/finance">http://www.bbk.ac.uk/mybirkbeck/finance</a></td>
</tr>
<tr>
<td>Rules and regulations relating to your MA</td>
<td>(including the Common Award Scheme) <a href="http://www.bbk.ac.uk/mybirkbeck/services/rules">http://www.bbk.ac.uk/mybirkbeck/services/rules</a></td>
</tr>
<tr>
<td>Late work and mitigating circumstances</td>
<td><a href="http://www.bbk.ac.uk/mybirkbeck/services/administration/assessment/coursework/mitigating-circumstances">http://www.bbk.ac.uk/mybirkbeck/services/administration/assessment/coursework/mitigating-circumstances</a></td>
</tr>
</tbody>
</table>

**Support**

Each student is assigned a personal tutor. For advice and information you can turn to this personal tutor, to the lecturers teaching you, to your Programme Director whom you may contact by e-mail or phone. Any matters concerning the course should be taken up with the course director. You may discuss medical problems in strict confidence. You are strongly advised to maintain regular contact with your personal tutor.

You may also take up issues with the Student Union. You become a member of the Union automatically as a registered Birkbeck student. Information on the services they offer are available on their website: [www.bbk.ac.uk/su](http://www.bbk.ac.uk/su) or phone 020 7631 6335.

**Representation**

Each year, we ask for two or more students from the MA to represent your concerns to programme tutors. These representatives collate student feedback to present at a termly ‘staff/student forum’ meeting, where issues specific to your experience as a student on the MA in Creative Writing are discussed.
JULIA BELL  
**Senior Lecturer in Creative Writing | MA Course Director | Novelist | Editor**  
Julia Bell is the author of three novels – *Massive* (Macmillan, 2002), *DirtyWork* (Macmillan, 2007), *The Dark Light* (Macmillan, 2015). Also co-editor of the bestselling *Creative Writing Coursebook* (Macmillan 2001) She is the editor of several volumes of short stories, most recently *The Sea in Birmingham* (Tindal Street Fiction Group, 2014) She is also the founder and project co-ordinator of Birkbeck’s annual literary magazine, *The Mechanics’ Institute Review* and *Writers Hub* website. Her work reflects an interest in feminist readings of culture, the problems and paradoxes of British regional identity, and the need to invigorate and champion independent publishing in an age of globalized media. Her website is at [www.juliabell.net](http://www.juliabell.net)  
Jh.bell@bbk.ac.uk

RUSSELL CELYN JONES  
**Professor of Creative Writing | MA Course Tutor | Novelist | Critic**  
r.jones@bbk.ac.uk

TOBY LITT  
**Senior Lecturer in Creative Writing | MA Course Tutor | Novelist | Critic**  
Toby Litt is the author of eight novels and four short story collections. His most recent book is a collection of his essays on literature, *Mutants* (Seagull Press, 2016). He has also written comics including the *Dead Boy Detectives* monthly series and, in collaboration with Neil Gaiman, *Free Country: A Tale of Children’s Crusade* (Vertigo, 2015). He is currently working on a non-fiction book about his great-great-great grandfather, William Litt, who was a champion wrestler, poet, novelist, and smuggler. Toby was chosen as one of Granta’s Best of Young British Novelists in 2003. Along with Ali Smith, he edited the *New Writing 13* anthology. He reviews for *The Guardian*, and appears regularly on Radio 3’s *The Verb*. He is a member of English PEN. His website is at [www.tobylitt.com](http://www.tobylitt.com).  
t.litt@bbk.ac.uk
COLIN TEEVAN  
Professor of Playwriting | Screenwriter  
Colin's plays include The Kingdom (Soho Theatre, 2012) There Was A Man, There Was No Man and The Lion of Kabul (Tricycle Theatre, 2012 and 2009); How Many Miles to Basra? (West Yorkshire Playhouse, winner of Clarion Best Play 2007); Amazonia (Young Vic); The Diver and The Bee (both with Hideki Noda for Soho Theatre and Setagaya Theatre, Tokyo); Missing Persons: Four Tragedies and Roy Keane (Assembly Rooms/Trafalgar Studios, 2005); Alcmene in Corinth (Live! Theatre); Monkey! (Young Vic, 2002) and The Walls (National Theatre, 2001). His adaptations include Dr Faustus (West Yorkshire Playhouse, 2013), Kafka's Monkey (Young Vic, 2009), and Peer Gynt (National Theatre of Scotland/Barbican, 2009). His translations include Bacchae (National Theatre, 2002), and Cuckoos (Gate Theatre, 2000). His stage work is published by Oberon Books. Colin has written more than ten full-length plays for BBC Radios 3 and 4, including the award-winning Glass Houses (2007) and Marathon Tales with poet Hannah Silva for the London 2012 Olympics. He has written on many aspects of theatre including translation, adaptation, contemporary Irish Theatre and international collaboration. He has written episodes of Silk (BBC), Single Handed (RTE and ITV), Vera (ITV), his IFTA award winning original mini-series Charlie, starring Aiden Gillen, was broadcast in January 2015 on Irish State broadcaster, RTE and his new original five part TV drama Rebellion premiers in Ireland and the US in early 2016.

RICHARD HAMBLYN  
BACW Programme Director | Lecturer in Creative Writing | Non-fiction writer | Editor  
Richard Hamblyn has taught at a number of universities and was Writer in Residence at the UCL Environment Institute. His books include The Invention of Clouds, which won the 2002 Los Angeles Times Book Prize and was shortlisted for the BBC4 Samuel Johnson Prize; Terra: Tales of the Earth (Picador, 2009), a study of natural disasters; and The Art of Science (Picador, 2011), an anthology of readable science writing from the Babylonians to the Higgs boson. He has also written four illustrated books for the Met Office, and edited Daniel Defoe's first book, The Storm, for Penguin Classics. Richard's current projects include a critical edition of The Adventures of Baron Munchausen, and a book of true stories about made-up landscapes.

LUKE WILLIAMS  
BACW Tutor | Lecturer in Creative Writing | Novelist | Non-fiction writer  
Luke Williams won the Saltire Prize for his first novel The Echo Chamber (2011) and he is currently working on a second book that tells the story of the island of Diego Garcia. Luke’s writing is research-based and seeks, via collaborative practice and the use of selected constraints, to close the formal gap between history and story. His work is informed by studies in History at Edinburgh University and Creative Writing at UEA. He co-organises the occasional live literature night, Plum.
DAVID ELDRIDGE
BACW Tutor | Lecturer in Creative Writing | Playwright | Screenwriter

David Eldridge's plays have been performed at major new writing institutions in the UK, including The Royal Court Theatre, the Bush Theatre, the Finborough Theatre and the National Theatre. His stage adaptation of the film Festen transferred from the Almeida Theatre to the West End and Broadway. His play Market Boy, informed by his childhood working on a stall at Romford Market, played at the National Theatre's largest space, the Olivier in 2006; Under the Blue Sky was revived at the Duke of York's Theatre starring Chris O'Dowd, Catherine Tate and Francesca Annis in 2008; The Knot of the Heart played at the Almeida Theatre in 2011 and starred Lisa Dillon, for whom the role of Lucy was written; In Basildon, played at the Royal Court Theatre in 2012. In April, the Royal Exchange Theatre will open his new version of Miss Julie by August Strindberg, starring Maxine Peake.
## Contact Details

### Administrative Contacts

<table>
<thead>
<tr>
<th>Name</th>
<th>Program(s)</th>
<th>Phone Number</th>
<th>Email</th>
<th>Office Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amy Flaye</td>
<td>MA Creative Writing, MA Text and Performance, MA Renaissance Studies, MA Medieval Literature and Culture</td>
<td>0203 073 8372</td>
<td><a href="mailto:a.flaye@bbk.ac.uk">a.flaye@bbk.ac.uk</a></td>
<td>Room G19, 43 Gordon Square</td>
</tr>
<tr>
<td>Esther Ranson</td>
<td>BA English, BA Arts &amp; Humanities</td>
<td>0203 073 8378</td>
<td><a href="mailto:e.ranson@bbk.ac.uk">e.ranson@bbk.ac.uk</a></td>
<td></td>
</tr>
<tr>
<td>Annmarie Shadie</td>
<td>BA Creative Writing</td>
<td>0203 073 8379</td>
<td><a href="mailto:a.shadie@bbk.ac.uk">a.shadie@bbk.ac.uk</a></td>
<td></td>
</tr>
<tr>
<td>Anthony Shepherd</td>
<td>MPhil/PhD programme</td>
<td>0203 073 8374</td>
<td><a href="mailto:aj.shepherd@bbk.ac.uk">aj.shepherd@bbk.ac.uk</a></td>
<td></td>
</tr>
<tr>
<td>Sarah Walker</td>
<td>MA Cultural &amp; Critical Studies, MA Modern &amp; Contemporary Literature, MA Victorian Studies, MA Contemporary Literature and Culture</td>
<td>0203 073 8381</td>
<td><a href="mailto:sc.walker@bbk.ac.uk">sc.walker@bbk.ac.uk</a></td>
<td></td>
</tr>
<tr>
<td>TBC</td>
<td>BA Theatre and Drama Studies, BA Theatre and English, MFA Theatre Directing</td>
<td>0203 073 8381</td>
<td>TBC</td>
<td></td>
</tr>
</tbody>
</table>

### Academic Contacts

<table>
<thead>
<tr>
<th>Name</th>
<th>Program(s)</th>
<th>Phone Number</th>
<th>Email</th>
<th>Office Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Julia Bell</td>
<td><a href="mailto:jh.bell@bbk.ac.uk">jh.bell@bbk.ac.uk</a></td>
<td>205, 43 Gordon Sq</td>
<td>020 3073 8217</td>
<td></td>
</tr>
<tr>
<td>Programme Director</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Russell Celyn-Jones</td>
<td><a href="mailto:r.jones@bbk.ac.uk">r.jones@bbk.ac.uk</a></td>
<td>212, 43 Gordon Sq</td>
<td>020 3073 8223</td>
<td></td>
</tr>
<tr>
<td>Toby Litt</td>
<td><a href="mailto:t.litt@bbk.ac.uk">t.litt@bbk.ac.uk</a></td>
<td>310, 43 Gordon Sq</td>
<td>020 3073 8210</td>
<td></td>
</tr>
</tbody>
</table>
## Appendix A: Term Dates and Deadlines

<table>
<thead>
<tr>
<th>Autumn Term</th>
<th>Spring Term</th>
<th>Summer Term</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monday 3 October 2016 to Friday 16 December 2016</td>
<td>Monday 9 January 2017 to Friday 24 March 2017</td>
<td>Monday 24 April 2017 to Friday 7 July 2017</td>
</tr>
<tr>
<td><strong>Week 1</strong></td>
<td><strong>Week 1</strong></td>
<td><strong>Week 1</strong></td>
</tr>
<tr>
<td>3-Oct-16</td>
<td>9-Jan-17</td>
<td>24-Apr-17</td>
</tr>
<tr>
<td><strong>Week 2</strong></td>
<td><strong>Week 2</strong></td>
<td><strong>Week 2</strong></td>
</tr>
<tr>
<td>10-Oct-16</td>
<td>16-Jan-17</td>
<td>1-May-17</td>
</tr>
<tr>
<td><strong>Week 3</strong></td>
<td><strong>Week 3</strong></td>
<td><strong>Week 3</strong></td>
</tr>
<tr>
<td>17-Oct-16</td>
<td>23-Jan-17</td>
<td>8-May-17</td>
</tr>
<tr>
<td><strong>Week 4</strong></td>
<td><strong>Week 4</strong></td>
<td><strong>Week 4</strong></td>
</tr>
<tr>
<td>24-Oct-16</td>
<td>30-Jan-17</td>
<td>15-May-17</td>
</tr>
<tr>
<td><strong>Week 5</strong></td>
<td><strong>Week 5</strong></td>
<td><strong>Week 5</strong></td>
</tr>
<tr>
<td>31-Oct-16</td>
<td>6-Feb-17</td>
<td>22-May-17</td>
</tr>
<tr>
<td><strong>Week 6</strong></td>
<td><strong>Week 6</strong></td>
<td><strong>Week 6</strong></td>
</tr>
<tr>
<td>7-Nov-16</td>
<td>13-Feb-17</td>
<td>29-May-17</td>
</tr>
<tr>
<td><strong>Week 7</strong></td>
<td><strong>Week 7</strong></td>
<td><strong>Week 7</strong></td>
</tr>
<tr>
<td>14-Nov-16</td>
<td>20-Feb-17</td>
<td>5-Jun-17</td>
</tr>
<tr>
<td><strong>Week 8</strong></td>
<td><strong>Week 8</strong></td>
<td><strong>Week 8</strong></td>
</tr>
<tr>
<td>21-Nov-16</td>
<td>27-Feb-17</td>
<td>12-Jun-17</td>
</tr>
<tr>
<td><strong>Week 9</strong></td>
<td><strong>Week 9</strong></td>
<td><strong>Week 9</strong></td>
</tr>
<tr>
<td>28-Nov-16</td>
<td>6-Feb-17</td>
<td>19-Jun-17</td>
</tr>
<tr>
<td><strong>Week 10</strong></td>
<td><strong>Week 10</strong></td>
<td><strong>Week 10</strong></td>
</tr>
<tr>
<td>5-Dec-16</td>
<td>13-Mar-17</td>
<td>26-Jun-17</td>
</tr>
<tr>
<td><strong>Week 11</strong></td>
<td><strong>Week 11</strong></td>
<td><strong>Week 11</strong></td>
</tr>
<tr>
<td>12-Dec-16</td>
<td>20-Mar-17</td>
<td>3-Jul-17</td>
</tr>
</tbody>
</table>

Most services will be unavailable from 5pm on Friday 16 December 2016, re-opening at 9am on Monday 9 January 2017.

Most services will be unavailable from Friday 25 March to Friday 1 April inclusive. **Normal services will resume from 9am on Monday, 24 April 2017**.

Most services will be unavailable on Monday 1 May & Monday 29 May 2016.

### Autumn Term

**Induction for all new MA Students**
Monday 26 September 2016

**Launch Party for Mechanics’ Institute Review**
Tuesday 27 September 2016

**Writing & Reading Seminar begins**
Wednesday 3 October 2016

**Contemporary Literature Modules begin**
Week beginning 1 October 2016

**Reading week no classes**
Week beginning 7 November 2016

### Spring Term

**Deadline for coursework**
Monday 9 January 2017

**Option Modules begin**
Week beginning 9 January 2017

**Writing Workshop begins**
Wednesday 11 January 2017

**Reading week no classes**
Week beginning 13 February 2017

### Summer Term

**Deadline for coursework**
24 April 2017

### Dissertation Deadline

**Full-time and year 2 part-time students: Friday 15 September 2017**

**Year 1 part-time students: Mid-September 2017 (exact date tbc)**
Appendix B: How to Format Your Fiction and Prose Non-Fiction

by Benjamin Wood

This document is intended to give you, the creative writing student, a general template you can refer to in order to correctly format your fiction for your assignments. It represents the standard expectations of publishers, agents, and literary journals for manuscript submissions. As you can see, the prose is double-spaced; in Microsoft Word, you do this by going to Format > Paragraph > Line Spacing > Double. This makes the prose easy to read, and gives your lecturer/editor ample space to write interstitial comments.

It is also typewritten in a sensible font (Gill Sans – though Times New Roman, Arial, Verdana, or Garamond are other good, sensible fonts) and in a sensible font size (11pt or 12pt). Further, there are ample margins of 2.5cm (Left), 2.5cm (Right), 2.5cm (Top) and 2.5cm (Bottom). You can alter the margins in Microsoft Word by going to Format > Document > Margins. The text can be justified or simply left-aligned. Pages should always be printed single-sided.

“Dialogue is indented like this,” one person said.

“And the first line of long passages of dialogue such as this, which are so long that they take up another line, are indented too,” someone replied.

In fact, every first line of every new paragraph is indented in this way. You can set up Microsoft Word to do this automatically by going to Format > Paragraph > Special > First Line.

When you want to indicate a large break in narrative time between scenes, you do so by leaving two paragraph spaces and left-aligning the prose, like this. (You should only
do this when there are significant gaps in narrative time you want to imply to the reader; never do this between paragraphs of continuous action in the same scene.)

When you move onto the next paragraph, the first line should be indented again, like this. Make sure that you don’t leave additional spaces between your paragraphs by adjusting your settings in MS Word. Go to: Format > Paragraph > Spacing and check the tick-box beside “Don’t add space between paragraphs of the same style”, or “Remove Space After Paragraph”.

It seems like this sort of thing is not very important but, in fact, it is. Correct formatting creates the impression of professionalism, indicating to agents and editors that you are a writer who knows what you are doing.

Other things to note: your pages should be numbered (ideally in the bottom right-hand corner of every page). You do this in Microsoft Word by going to Insert > Page Numbers. And you should include a word count at the end of your manuscript. You can find out what your word count is by going to Tools > Word Count.

Happy writing!

(448 words)
Appendix C: Extracurricular Opportunities

Get Involved!

http://mironline.org/

The Mechanics' Institute Review is an exciting and recently relaunched interactive web portal which aims to provide a platform for high-quality new fiction, non-fiction and poetry, as well as reviews and interviews.

This site is managed by Project Director, Julia Bell, and maintained and edited by a rotating group of Birkbeck students, alumni and staff. The Managing Editor is Melanie Jones. The current Short Fiction editor is Toby Litt. Julia Bell is the Creative Non-Fiction Editor and Stephen Willey is Poetry Editor. Submissions can be made to editor@mironline.org.

We are always looking for people to contribute reviews, blogs, stories, poems and ideas for features and interviews. We also need volunteers to help manage and develop the site, and to join the editorial committee and we have an ongoing intern programme.

Email Melanie Barry if you're interested in finding out more: melanie.louise@gmail.com
Appendix D: Getting Started with Moodle

Logging in and getting started

All modules within the School of Arts use Moodle (a Virtual Learning Environment, or VLE) for circulating module information and coursework submission.

- To log in to Moodle you will need your ITS username and password, a computer with a connection to the internet and a web browser such as Internet Explorer or Firefox.

- If you are having login problems, but your password is working for other services, please change your password via the online form at [http://www.bbk.ac.uk/its/password](http://www.bbk.ac.uk/its/password) (allow one hour after completing this form, and then log in again). If this hasn't resolved the problem please contact the ITS Helpdesk via email (its@bbk.ac.uk), telephone (020 7631 6543), or in person (Malet St building, next to the entrance to the Library).

- There is support information available in Moodle if you click on the Support menu and select ‘Moodle Support for Students’.

Contact ITS: You can contact the ITS Helpdesk via email (its@bbk.ac.uk), telephone (020 7631 6543), or in person (Malet St building, next to the entrance to the Library).
Appendix E: Campus Map

www.bbk.ac.uk/maps